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CHAPTER 1 - What Is Adobe Illustrator and Why Learn It? 
 

"I remember the first time I opened Illustrator. I stared at a blank white canvas, 
moved the mouse around, and closed the app within four minutes." 
Twenty-five years later, that same blank canvas is where I spend most of my working 
day — and I genuinely look forward to it every morning. This chapter will make sure 
your first experience is considerably better than mine. 

 

WHAT YOU WILL LEARN IN THIS CHAPTER 
What vector graphics are and why they matter in professional design 
How Adobe Illustrator is used in the real world — from logos to billboards 
The key differences between Illustrator, Photoshop, and Canva (and when to use 
each) 
How Illustrator 2026 is different from older versions 
How to set realistic expectations as a complete beginner 

 

1.1  The Two Types of Digital Image — And Why It Matters 
Before we talk about Illustrator, we need to talk about something more fundamental: the 
two completely different ways a computer stores a picture. Understanding this distinction 
is one of the most important things you can learn as a designer. It will shape every tool 
choice you make for the rest of your career. 

Raster Images: Made of Pixels 
Open any photograph on your phone and zoom in as far as you can. At some point you 
will see tiny coloured squares. Those squares are pixels — and an image built from a 
grid of pixels is called a raster image (sometimes called a bitmap image). 

Every pixel in a raster image has an exact colour value. A 10-megapixel photo has 10 
million of those coloured squares, all locked in place. Programs like Adobe Photoshop 
and apps like Lightroom are built specifically to work with raster images. So is every 
photo you have ever taken with a camera or smartphone. 

The critical limitation of raster images is this: they are tied to a fixed size. If you design a 
logo as a raster image at 500 pixels wide and then someone asks you to put it on a 
billboard, you are in trouble. Stretching it larger just makes those pixels bigger — the 
result looks blurry and unprofessional. Designers call this "going pixelated" or "going 
jaggy." 

REAL-WORLD EXAMPLE 
A small business owner asks a designer for a logo. The designer creates it in 
Photoshop at a small size. Six months later, the business wants the logo printed on 
a 3-metre shop sign. The raster logo looks terrible at that size — blurry and soft. 
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The designer has to rebuild it from scratch. This is a very common (and expensive) 
mistake that you will never make once you understand vectors. 

 

Vector Images: Made of Maths 
A vector image stores artwork as mathematical instructions rather than a grid of pixels. 
Instead of recording "pixel number 4,502 is the colour orange," a vector file says 
something like: "draw a circle, centred here, with this radius, filled with this colour." 

When you resize a vector image, the software simply recalculates the maths. A vector 
logo that looks perfect at business-card size will look exactly as sharp on a 10-metre 
building wrap. The edge stays crisp at any size, on any screen, at any print resolution. 
This quality is called being resolution-independent, and it is the defining superpower of 
vector graphics. 

Adobe Illustrator is the world’s leading vector graphics application. Everything you 
create in Illustrator — every shape, every line, every letter — is stored as vector data. 
That is why it is the professional standard for logos, icons, typography, illustrations, and 
any artwork that needs to scale. 

 

Side-by-Side Comparison 
 

Feature Raster (Photoshop) Vector (Illustrator) 

Built from Pixels (tiny coloured 
squares) 

Mathematical paths and 
points 

Resize behaviour Gets blurry when enlarged Stays perfectly sharp at any 
size 

File size Can be very large Usually small and efficient 

Best for Photos, realistic textures Logos, icons, typography, 
illustrations 

Common file types JPG, PNG, PSD, TIFF AI, SVG, EPS, PDF 

Zoom in far enough and... You see individual pixels It stays sharp forever 

 
Keep this table in mind whenever you start a new design project. Ask yourself: will this 
artwork ever need to be printed large, used at different sizes, or reproduced on different 
materials? If yes — Illustrator is almost certainly the right tool. 

✏✏  TRY IT NOW  —  See the difference for yourself 
1. Find any JPEG image on your computer (a photo works perfectly). 
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2. Open it in any image viewer and zoom in to 400% or more. 
3. Notice how it becomes blurry and you can see the individual pixel squares. 
4. Now think about a company logo you know. Imagine zooming into the 

original Illustrator file the designer used — it would stay perfectly sharp no 
matter how far you zoomed. That is the power you are about to learn. 

 

1.2  What Do People Actually Use Illustrator For? 
One of the biggest myths about Adobe Illustrator is that it is only for professional graphic 
designers at large agencies. In 25 years of using this software, I have seen it used by 
architects, surgeons, farmers, musicians, teachers, engineers, and stay-at-home 
parents — all making genuinely professional work. 

Let’s look at what real people create with Illustrator every single day. 

Logos and Brand Identity 
This is probably the most well-known use case, and for good reason. Every major brand 
logo you can think of — from Nike to Netflix, from Apple to Airbnb — was either created 
in Illustrator or lives in Illustrator as its "master" file. When a brand sends its logo to a 
printer, a sign manufacturer, a clothing company, or a web developer, they send a 
vector file from Illustrator. It will look identical at every size and on every material. 

As a beginner, designing logos is also one of the best ways to practice core Illustrator 
skills: shapes, the Pen tool, typography, and colour. By the end of this book, you will 
design a complete logo from scratch. 

Icons and User Interface Elements 
Every icon you tap on your phone — the share button, the heart symbol, the menu icon 
— was almost certainly designed in Illustrator (or a tool that works very similarly). App 
icons, website buttons, social media icons, and the tiny symbols you see in maps and 
airline boarding passes are all vector artwork. 

Icon design is a fast-growing freelance skill. A single well-designed icon set can be sold 
on stock platforms and generate ongoing income. 

Posters, Flyers and Print Design 
Event posters, concert flyers, restaurant menus, wedding invitations, book covers, 
magazine layouts — all of these live happily in Illustrator. The software handles both text 
and graphics in one place, and its output is print-ready without any extra steps. 

PRO TIP   
When I teach beginners, I always suggest starting with a poster or flyer as their first 
real project. Why? Because the skills you need are clear and practical: placing text, 
using shapes for layout, picking colours, and exporting a finished file. You get a 
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tangible result you can actually use or share. The same skills transfer directly to 
logos, icons, and every other project type. 

 

Social Media Graphics 
Instagram posts and Stories, YouTube thumbnails, LinkedIn banners, Twitter/X headers, 
Pinterest graphics — Illustrator is excellent for all of these. You can set up multiple 
artboards (Illustrator’s version of separate canvases) inside a single file, one for each 
platform size, and design across all of them simultaneously. 

With Illustrator 2026, you can even connect directly to Adobe Express to hand off 
designs to non-designer colleagues who need to make small edits without touching the 
original file. 

Packaging and Product Design 
Look at the cereal box on your kitchen shelf. The label on a wine bottle. The hang tag on 
a piece of clothing. All of that artwork was created in Illustrator (or a similar vector tool). 
Packaging design requires perfectly scalable artwork that can be sent to industrial 
printers, and vector files are the only format those printers accept. 

Infographics and Data Visualisation 
Charts, diagrams, maps, timelines, and illustrated data stories are an increasingly 
important part of journalism, marketing, and business communication. Illustrator gives 
you full control over every visual element, producing infographics that are clean, 
scalable, and ready to publish in any format. 

T-shirts, Merchandise and Print-on-Demand 
Print-on-demand platforms like Redbubble, Merch by Amazon, and Printful all require 
vector files for their products. If you want to sell artwork on t-shirts, mugs, phone cases, 
or tote bags, learning Illustrator is a direct path to income. 

 

INDUSTRIES THAT USE ILLUSTRATOR EVERY DAY 
Graphic design and branding agencies 
In-house marketing and communications teams 
Advertising and media production 
Fashion and apparel design 
Packaging and product design 
Architecture and technical illustration 
Publishing (books, magazines, newspapers) 
Game design (UI elements, concept art, icons) 
Education and e-learning (diagrams, workbooks) 
Film and television (titles, motion graphics prep) 
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Freelancing and print-on-demand businesses 

 

1.3  Illustrator vs Photoshop vs Canva: Which Should You Use? 
This is the question I am asked most often by beginners, so let’s answer it properly. 
These three tools are not competitors in the way that Pepsi and Coca-Cola are 
competitors. They are built for different tasks. Knowing when to use each one is a 
professional skill in itself. 

Adobe Illustrator: The Vector Specialist 
Use Illustrator when your artwork needs to scale, when precision matters, when you are 
working on anything that will be printed professionally, or when you are creating logos, 
icons, typography-heavy designs, illustrations, or packaging. 

Illustrator gives you complete control over every anchor point, every curve, every colour. 
It has a learning curve, but the level of precision and quality it produces is why every 
professional design studio in the world uses it. 

Adobe Photoshop: The Photo Expert 
Use Photoshop when you are working with photographs, when you need realistic 
textures and painterly effects, or when you need to composite (combine) multiple photos 
together. Photoshop excels at manipulating existing images — retouching skin, 
removing backgrounds from photos, adding realistic lighting effects. 

Photoshop is not the right tool for a logo. If you create a logo in Photoshop, it will look 
perfect on screen but will be unprintable at large sizes. Many beginners make this 
mistake. Now you will not. 

Canva: The Quick Template Tool 
Canva is a browser-based tool built around pre-made templates. It is designed for non-
designers who need to produce social media posts or presentations quickly using drag-
and-drop elements. It is genuinely useful for that purpose. 

However, Canva is not a professional design tool. It does not produce true vector 
output, it gives you very limited creative control, and most employers and clients in the 
design industry do not accept Canva files. If your goal is to work in design 
professionally, build a freelance income, or create truly original work, you need 
Illustrator. 

Think of it this way: Canva is a microwave oven. It is quick, convenient, and fine for 
everyday use. Illustrator is a professional kitchen. It takes longer to learn, but the results 
are in a completely different class. 
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 Illustrator 2026 Photoshop Canva 

Primary use Vector design & 
illustration 

Photo editing & 
compositing 

Template-based 
graphics 

Output quality Professional / print-
ready 

Professional / print-
ready 

Screen use only 

Scales to any size? Yes — always 
perfect 

No — pixels 
degrade 

Limited 

Skill required Medium (worth it) Medium Very low 

Accepted by 
printers? 

Yes (EPS, PDF, 
SVG) 

Sometimes (300dpi 
PNG) 

Rarely 

Best for beginners 
building a career? 

Yes — industry 
standard 

As a complement No 

AI-powered features 
(2026) 

Firefly deeply 
integrated 

Firefly integrated Basic AI tools 

 

DO I NEED PHOTOSHOP TOO? 
Not to start with. Illustrator 2026 can now remove image backgrounds, extend 
backgrounds, and work with photos directly inside the app — features that used to 
require a trip to Photoshop. For most beginners, Illustrator alone will cover 
everything you need for months. Once you are comfortable with Illustrator, you can 
explore Photoshop to round out your skill set. 

 

1.4  What’s New in Illustrator 2026? 
Adobe releases a major update to Illustrator every year, usually in October at the Adobe 
MAX conference. The 2026 version (version 30.x) is, in my opinion, the most significant 
update in at least five years. If you are picking up Illustrator for the first time now, you 
are starting at a genuinely exciting moment. 

Here are the most important things that are new, explained in plain English: 

It Is Dramatically Faster 
Illustrator 2026 launches up to 3× faster than older versions and saves files up to 6× 
faster. That may not sound important until you have spent your time watching a loading 
screen. For beginners, faster feedback makes learning much more enjoyable. For 
working designers, it is a significant productivity gain. 

The speed improvements come from deep optimisation for Apple Silicon (M-series 
Macs) and Windows ARM processors, plus a smarter saving system that only writes the 
changes you made rather than rewriting the entire file from scratch. 
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AI Is Built Into the Canvas 
Adobe has integrated its Firefly AI engine directly into Illustrator 2026. This means you 
can type a text prompt and generate editable vector artwork without leaving your file. 
This is called Text to Vector Graphic, and it is genuinely remarkable. 

There is also Concept to Vector, which converts a rough sketch or a raster photo into 
fully editable vector artwork. If you have an idea sketched on paper, you can photograph 
it, bring it into Illustrator 2026, and have a clean vector version within seconds. 

We cover all of these AI features in detail in Part 4. For now, just know they exist and 
that this book will teach you how to use them responsibly and effectively. 

Turntable: Multi-Angle Views Without 3D Software 
A new feature called Turntable (currently in Beta) lets you view your vector artwork from 
multiple angles, almost like a simple 3D rotation. This is extremely useful for product 
designers, package designers, and anyone creating mockups. Previously, achieving this 
effect required a separate 3D application. 

Better Gradients 
Gradients in Illustrator 2026 now support dithering (which eliminates those ugly colour 
banding stripes you used to see in subtle gradients) and a new Perceptual blending 
mode that makes colour transitions look far more natural to the human eye. This might 
sound like a small detail, but for any design involving smooth colour gradients — 
backgrounds, illustrations, packaging — it is a meaningful quality improvement. 

Collaboration Features 
A new Projects system lets teams collaborate on Illustrator files, and tighter integration 
with Adobe Express means a designer can hand off assets to a non-designer colleague 
without sending them into the full Illustrator environment. 

Refreshed Font Browser 
Finding the right font used to require a lot of scrolling. The 2026 Font Browser is 
redesigned with better visual previews and filtering, making typography decisions faster 
and more intuitive. 

 

A NOTE ON AI FEATURES 
AI tools in Illustrator 2026 are genuinely useful, and this book covers all of them. 
However, I want to be clear about something from the start: AI does not replace the 
need to learn Illustrator properly. AI in Illustrator generates a starting point — a 
rough vector shape you then edit, refine, and integrate into your design. The better 
your core Illustrator skills, the more effectively you can use the AI tools. Think of AI 
as a fast pencil sketch, not a finished painting. 

 

1.5  What to Expect as a Complete Beginner 
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I want to be honest with you about the learning curve, because I think most tutorials and 
books are not honest enough. 

Illustrator is not difficult to learn. But it does require patience in the early stages. There 
are two tools that almost every beginner finds frustrating at first: 

• The Pen tool. This is the tool you use to draw custom shapes and paths by 
placing anchor points. It feels nothing like drawing with a real pen. It has its own 
logic, and it takes practice before it feels natural. Chapter 5 of this book is 
dedicated entirely to the Pen tool, and I will take you through it step by step in a 
way that actually makes sense. 

• The coordinate system. Illustrator thinks about position and size in exact 
numbers (x coordinate, y coordinate, width, height). Coming from a world where 
you drag things around freely, this precision can feel constraining. Within a few 
hours of practice, it becomes an enormous strength. 

 
Everything else in Illustrator follows a clear and learnable logic. Once you understand 
the fundamentals — shapes, paths, colours, and layers — the rest builds on those 
foundations naturally. 

A Realistic Timeline 
Based on teaching hundreds of beginners over the years, here is what you can 
realistically expect if you work through this book consistently: 

 
Timeframe What You Will Be Able to Do 

After 2–3 hours Navigate the workspace, draw basic 
shapes, apply colours, save files 

After 1 day (6–8 hours) Create simple logos and icons, use the Pen 
tool for basic paths, work with text 

After 1 week Design posters, social media graphics, 
work with layers and effects confidently 

After 1 month Complete professional-quality work, use AI 
features effectively, export for print and 
screen 

After 3 months Build a portfolio, take on freelance projects, 
work at industry speed 

 
These timelines assume you are practising actively — not just reading, but opening 
Illustrator and doing the exercises in this book. Reading alone will not make you a 
designer. Doing the work will. 

THE SINGLE MOST IMPORTANT PIECE OF ADVICE I CAN GIVE YOU 
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Open Illustrator alongside this book and follow every example as you read it. Do not 
read a chapter and then open the software later. Keep both open at the same time. 
The muscle memory you build by actually clicking, dragging, and creating is what 
will make these skills permanent. Reading about the Pen tool and using the Pen tool 
are completely different experiences. 

 

1.6  How This Book Is Structured 
This book is designed to take you from "I have never opened Illustrator" to "I can create 
professional work and take on real projects." It is structured in five parts: 

• Part 1 (Chapters 1–3): Welcome to Illustrator 2026. You are here. This part 
covers the fundamentals of what Illustrator is, how to install and set it up, and 
how to navigate the workspace without feeling lost. 

• Part 2 (Chapters 4–8): Core Tools and Fundamental Skills. The essential 
tools: shapes, the Pen tool, colour, type, and transformations. These chapters are 
the foundation everything else is built on. 

• Part 3 (Chapters 9–13): Intermediate Techniques and Real Projects. Layers, 
effects, brushes, working with images, and a complete logo project from start to 
finish. 

• Part 4 (Chapters 14–18): AI-Powered Features and Advanced Workflows. 
Firefly AI, the Turntable feature, advanced typography, collaboration, and a full 
social media graphics project. 

• Part 5 (Chapters 19–20): Exporting, Printing and What’s Next. Getting your 
work out of Illustrator correctly for every possible use, plus a roadmap for where 
to take your skills from here. 

 
Throughout the book you will find three types of practical element: 

• TRY IT NOW boxes — short exercises you can do immediately, in under five 
minutes, to reinforce what you have just read. 

• Pro Tips — insights from real professional practice that textbooks rarely include. 
• Real-world examples — concrete scenarios showing how the skill you are 

learning is used in actual client work. 

 

1.7  Your First Action: Open Illustrator Right Now 
Before you move on to Chapter 2, I want you to do one thing. If you have Illustrator 
installed, open it now. If you do not, Chapter 2 will walk you through the installation. 

When Illustrator opens, you will see the Home Screen. Do not panic about all the 
options. Do not click anything yet. Just look at it for 30 seconds. Notice the templates, 
the recent files section, the big orange Illustrator logo in the corner. 
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You have just opened the most widely used vector design application in the world. The 
same application used to design the logos of companies worth billions. The same 
application used to design the packaging of products you buy every week. The same 
application that has shaped the visual world around you for the last three decades. 

In the next chapter, you are going to set it up properly and start making things. 

✏✏  TRY IT NOW  —  Your first two minutes in Illustrator 
5. Open Adobe Illustrator 2026 (or install it via Creative Cloud — see Chapter 

2). 
6. On the Home Screen, click 'New file'. 
7. In the dialog that appears, select 'A4' under the Print tab. 
8. Click 'Create'. 
9. You are now looking at a blank Illustrator artboard. This is your canvas. 
10. Press Ctrl+Z (Windows) or Cmd+Z (Mac) a few times — this is the Undo 

shortcut. You will use it hundreds of times. Good to know it already. 
11. Close the file without saving. You’re ready for Chapter 2. 

 

CHAPTER SUMMARY 
• Vector images are built from mathematical paths and scale to any size 

without losing quality. Raster images are built from pixels and degrade when 
enlarged. 

• Adobe Illustrator is the industry-standard vector design application, used for 
logos, icons, packaging, posters, illustrations, social media graphics, and 
much more. 

• Illustrator is different from Photoshop (which edits raster photos) and from 
Canva (a template tool for non-designers). Illustrator is the professional 
standard. 

• Illustrator 2026 (v30.x) is significantly faster, includes deeply integrated 
Firefly AI tools (Text to Vector, Concept to Vector, Generative Expand), a 
new Turntable feature, improved gradients, and better collaboration tools. 

• The best way to learn Illustrator is to keep it open alongside this book and 
complete every exercise as you encounter it. 

• A motivated beginner can create professional-quality work within one month 
of consistent practice. 
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CHAPTER 2 - Installing, Setting Up & Your First File 
 

"The difference between a professional designer and a beginner is not talent — it 
is a properly configured workspace." 
In this chapter, I am going to make sure you are set up exactly like a professional 
from day one — the right colour settings, the right preferences, and the right 
document setup. Every shortcut you learn today will save you hours next month. 

 

WHAT YOU WILL LEARN IN THIS CHAPTER 
How to install Illustrator 2026 via Adobe Creative Cloud step by step 
System requirements and how to check your computer meets them 
How to navigate the Home Screen and understand what everything does 
How to create a new document with the correct settings for print and screen 
What artboards are and how to set them up correctly 
The essential preferences to configure before you do any real work 
How to save your file correctly and avoid the most common beginner mistakes 

 

2.1  Do You Have a Subscription? Getting Access to Illustrator 
Adobe Illustrator 2026 is available exclusively through Adobe Creative Cloud — a 
subscription service. There is no one-time purchase option. Here is what you need to 
know before you install anything. 

Subscription Plans 
Adobe offers several plans. For a beginner who wants to learn Illustrator, there are three 
realistic options: 

Plan What's Included Best For 

Illustrator Single App Access to Illustrator only Most affordable option; 
good if you only need 
Illustrator 

Creative Cloud All 
Apps 

Access to all Adobe apps 
(Photoshop, InDesign, Premiere 
Pro, etc.) 

Best value if you plan to use 
multiple Adobe tools 

Creative Cloud Free 
Starter 

Limited free access to some 
Adobe tools 

Does not include full 
Illustrator; useful for 
exploring the ecosystem 

 

★★  PRO TIP   
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Adobe regularly runs promotions — especially at the start of the academic year and 
during Black Friday. If the price feels high right now, check Adobe's website for 
current offers. Students and teachers get a substantial discount through the 
Education plan. If you are enrolled in any educational institution, always check 
whether you qualify before paying full price. 

 
Once you have a subscription (or a free trial), go to adobe.com/creativecloud and sign in 
with your Adobe ID. If you do not have one, you can create one for free — your Adobe 
ID is the account that stores all your cloud assets, fonts, and preferences. 

 

2.2  System Requirements for Illustrator 2026 
Before installing, check that your computer meets the requirements. Illustrator 2026 is 
noticeably more demanding than older versions — particularly for AI features like Text to 
Vector and Concept to Vector — but it also runs more efficiently on modern hardware 
than any previous version. 

Minimum vs Recommended Specifications 
 

Component Minimum (it will 
run) 

Recommended (it 
will fly) 

Why It Matters 

Processor (CPU) Intel/AMD 64-bit with 
SSE 4.2+ or Apple 
M1 

Intel Core i7/i9, AMD 
Ryzen 7/9, or Apple 
M2/M3/M4 

Faster CPU = faster 
rendering, smoother 
Pen tool response 

RAM 8 GB 16 GB or more Complex files with 
many objects will 
slow down below 16 
GB 

Storage 4 GB free (SSD 
preferred) 

20 GB+ free on SSD SSD is the single 
biggest real-world 
speed upgrade 

GPU (Graphics 
Card) 

1 GB VRAM, 
OpenGL 4.0 

4 GB VRAM 
dedicated GPU 

GPU acceleration 
makes zoom, scroll 
and effects buttery 
smooth 

Display 1024 × 768 px 1920 × 1080 px or 
higher 

Higher resolution = 
more workspace 
visible at once 

Operating System Windows 10 (v21H2) 
/ macOS 13 Ventura 

Windows 11 / 
macOS 14 Sonoma 
or 15 Sequoia 

Newer OS = better 
performance and 
security 
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Component Minimum (it will 
run) 

Recommended (it 
will fly) 

Why It Matters 

Internet Required for 
activation 

Broadband for cloud 
sync and AI features 

AI features need 
internet; core tools 
work offline 

 

APPLE SILICON (M1/M2/M3/M4) — SPECIAL NOTE 
If you have a Mac with Apple Silicon (M1, M2, M3, or M4 chip), you are in luck. 
Illustrator 2026 has been deeply optimised for Apple Silicon and delivers the best 
performance of any platform. Launch times up to 3× faster and file saves up to 6× 
faster compared to Intel Macs. If you are choosing between Mac and Windows for 
design work, Apple Silicon is currently the gold standard for Illustrator performance. 

 

✏✏  TRY IT NOW  —  Check your system specs right now 
1. On Windows: Press the Windows key + Pause/Break key, or right-click the 

Start button and select 'System'. You will see your processor, RAM, and 
Windows version. 

2. On Mac: Click the Apple logo ( ) in the top-left corner, then select 'About 
This Mac'. You will see your chip, RAM, and macOS version. 

3. Compare what you see against the Recommended column above. 
4. If your RAM is below 8 GB, note that some features (especially AI tools) may 

run slowly. The rest of the software will still work. 
5. If your OS is older than what's listed in the Minimum column, you should 

update it before installing Illustrator. 

 

2.3  Installing Creative Cloud and Illustrator 2026 
Installation has two steps: first you install the Creative Cloud Desktop App (a small 
management application), and then you use it to install Illustrator. This two-step process 
is how Adobe manages all its applications. 

Step 1 — Install the Creative Cloud Desktop App 
1. Open a web browser and go to: adobe.com/creativecloud/desktop-app 
2. Click the Download button. This downloads a small installer file (approximately 2 

MB). 
3. Run the installer. On Windows, double-click the .exe file and click Yes when 

asked for permissions. On Mac, double-click the .dmg file, drag the app to 
Applications, and open it. 

4. The Creative Cloud Desktop App will open and ask you to sign in. Use the Adobe 
ID you created or the account your subscription is linked to. 
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5. You will now see the Creative Cloud interface shown below. 

 

      

In the Creative Cloud Desktop App, click 'Apps' in the left sidebar (see annotation ① in 
the figure above). 

6. In the search bar at the top, type 'Illustrator'. 
7. If Illustrator shows 'Install': click it. The installer is approximately 2–3 GB, so 

this will take a few minutes depending on your internet speed. 
8. If Illustrator shows 'Open': it is already installed. You are ready to go. 
9. If Illustrator shows 'Update': click Update to get the 2026 version (v30.x). 
10. When installation is complete, the button will change to 'Open'. Click it, or launch 

Illustrator from your Applications folder (Mac) or Start menu (Windows). 

 

★★  PRO TIP   
When Illustrator installs, it also installs Adobe Fonts — a library of over 20,000 
professional typefaces that sync automatically to Illustrator and all other Adobe 
apps. You do not need to do anything to activate these. They are one of the most 
underrated benefits of the Creative Cloud subscription. We cover fonts in detail in 
Chapter 7. 

 

⚠⚠  COMMON MISTAKE — AVOID THIS 
Do NOT close the Creative Cloud Desktop App after installing Illustrator. It needs to 
run in the background to keep your licence active and to sync fonts, libraries, and 
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cloud assets. You can minimise it to the system tray (Windows) or the menu bar 
(Mac), but do not quit it while working in Illustrator. If Illustrator ever says your trial 
has expired when you have a paid subscription, re-opening the Creative Cloud app 
usually resolves it. 

 

2.4  The Home Screen — Your First Look at Illustrator 
When you launch Illustrator 2026 for the first time, you will see the Home Screen. This is 
not the design workspace — it is a launchpad. Let’s understand everything on it before 
we move further. 

 

 
Figure 2.5 — Illustrator 2026 Home Screen. The four areas you need to know are labelled. 

The Four Areas of the Home Screen 
• ①① The App Sidebar (far left). The small column on the left contains icons for 

navigation: your recent files, starred (favourite) files, shared files, and cloud 
storage. You will use the Recent files icon daily. 

• ②② The '+ New file' button (top right). This is how you start a new design 
project. We will click this in the next section. 

• ③③ Recent Files. Every file you have opened recently appears here as a 
thumbnail. Single-click to open. Right-click for options (rename, duplicate, reveal 
in Finder/Explorer). 

• ④④ Templates. Adobe provides professionally designed starting points for social 
media, print, web, and more. Using a template is completely legitimate — 
professionals use them as starting points all the time, especially for standard 
document sizes. 
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THE BLUE BANNER AT THE BOTTOM 
If you see a blue or orange banner at the bottom of the Home Screen saying 'What’s 
new in Illustrator 2026?' — click it. It launches an interactive tour of the new 
features. It takes about five minutes and will give you a useful overview of 
everything that is new. I recommend doing this before starting any project in a new 
version. 

 

2.5  Creating Your First Document 
Now we are going to create our first real Illustrator document. This is not just clicking 
New — the decisions you make in the New Document dialog affect the quality of your 
final output. Get these right from the start. 

Click the '+ New file' button on the Home Screen. The New Document dialog will open. 

 

         
• Photo: High-resolution settings for photography and photo editing (you would 

usually do this in Photoshop, but the preset exists). 
• Print: CMYK colour mode, 300 ppi resolution. Use this for anything that will be 

professionally printed: logos, posters, packaging, business cards, flyers. 
• Art & Illustration: RGB colour mode. Use this for digital illustrations, concept art, 

and artwork that will live on screen. 
• Web: RGB colour mode, pixel-based units. Use this for website graphics, UI 

elements, and icons. 
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• Film & Video: RGB, standard video dimensions (1920×1080, 4K, etc.). 
• Mobile: RGB, common phone and tablet screen sizes. 

 

★★  PRO TIP   
The single most common beginner mistake I see is creating a Print design in 
RGB mode, or a Web design in CMYK mode. RGB colours look bright and vivid on 
screen but can appear dull and different when printed. CMYK colours are optimised 
for ink. Always choose the correct tab before creating your document — changing 
colour mode later causes colour shifts and extra work. 

 

The Settings Panel (Right Side) 
Once you select a preset, the right-hand panel shows its settings. You can change any 
of these before clicking Create: 

 
Setting What It Means What to Choose as a Beginner 

Width / Height The size of your artboard 
(canvas) 

Use the preset size or type your 
own (e.g. 210 mm × 297 mm for 
A4) 

Units The measurement system (px, 
mm, inches, cm) 

mm for print, px for screen/web 

Orientation Portrait (taller than wide) or 
Landscape (wider than tall) 

Portrait for most documents; 
Landscape for presentations or 
banners 

Artboards How many canvases to start with Start with 1. You can always add 
more later. 

Bleed Extra space around the edge for 
print trimming 

3 mm for most professional print 
jobs. Leave at 0 for screen work. 

Color Mode RGB (screen) or CMYK (print) Set automatically by the tab you 
chose — do not change it unless 
you know why 

Raster Effects Resolution for effects like drop 
shadows 

High (300 ppi) for print; Screen 
(72 ppi) for web 
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Figure 2.4 — Common preset sizes for different output types. Note the colour mode: RGB for screen, 

CMYK for print. 

✏✏  TRY IT NOW  —  Create your first three documents 
6. Document 1 — A4 Print flyer: Click '+ New file', select the Print tab, click 

the A4 preset, confirm Color Mode is CMYK, set Bleed to 3 mm on all sides, 
click Create. 

7. Document 2 — Instagram Post: Click '+ New file', select the Mobile tab, 
find the Instagram Post preset (1080×1080 px), confirm Color Mode is RGB, 
click Create. 

8. Document 3 — Custom size: Click '+ New file', select the Web tab, type 
1920 in the Width field and 1080 in the Height field, ensure units are set to 
Pixels, click Create. 

9. You now have three documents open. Notice the tabs at the top of the 
screen — each tab is a separate open file. Click between them to switch. 

10. Close Document 2 and 3 for now (Ctrl+W / Cmd+W). Leave Document 1 
open. 

 

2.6  The Illustrator Workspace — A Guided Tour 
With your A4 document open, you are now looking at the Illustrator workspace. This is 
where all design work happens. Let’s name every part of it so you are never lost. 
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• Selection tool (V): The black arrow. Used to select and move objects. 
• Direct Selection tool (A): The white arrow. Used to select individual anchor 

points on a path. 
• Pen tool (P): For drawing custom shapes and paths. We devote all of Chapter 5 

to this. 
• Type tool (T): For adding text to your document. 
• Rectangle tool (M): For drawing rectangles and squares. 
• Ellipse tool (L): For drawing circles and ellipses. 
• Zoom tool (Z): For zooming in and out. (Keyboard shortcut: Ctrl/Cmd + or – is 

faster.) 

 

TOOL SHORTCUTS — MEMORISE THESE FIRST 
Almost every tool has a single-letter keyboard shortcut. Press V to activate the 
Selection tool, P for the Pen tool, T for the Type tool. This is how professional 
designers work — left hand on the keyboard for shortcuts, right hand on the 
mouse/tablet. You do not need to memorise all the shortcuts now; focus on V, A, P, 
T, M, L, and Z for the first week. 

④④ The Canvas and Artboard 
The white rectangle in the centre of the screen is your artboard — this is your actual 
design canvas. Anything placed on the artboard will appear in your final exported file. 
The grey area around it is the pasteboard — you can temporarily place objects here 
while working, but they will not export. 
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The artboard label ('Artboard 1') appears above the top-left corner. If you have multiple 
artboards, each one is labelled and numbered. ⑤⑤ The Panels (Right Side) 
Panels are the floating windows docked on the right side of the screen. They give you 
precise control over every aspect of your design. The most important panels to know: 

• Properties panel: Shows the most relevant settings for whatever you have 
selected. A great all-in-one panel for beginners. 

• Layers panel: Manages the stacking order and organisation of all objects in your 
document. Critical once your designs have more than a few elements. 

• Color panel: For applying and editing colours. 
• Swatches panel: Your saved colour palette. 
• Libraries panel: Stores and syncs assets (colours, graphics, type styles) across 

documents and devices. 
You can show or hide any panel from the Window menu. If a panel you need is not 
visible, go to Window → find the panel name. ⑥⑥ The Contextual Task Bar 
New in recent versions and refined in 2026, the Contextual Task Bar is a small floating 
bar near the bottom of the canvas. It changes based on what you have selected and 
suggests the most relevant next actions. If you select a shape, it offers Pathfinder 
operations. If you use the Text tool, it shows type formatting options. If you select an 
image, it offers background removal and tracing. 

As a beginner, think of the Contextual Task Bar as Illustrator gently pointing you towards 
what to do next. It is genuinely useful and I recommend keeping it visible (View → Show 
Contextual Task Bar). 

 

2.7  Essential Preferences to Set Before You Start Working 
Most beginners launch Illustrator and start designing without ever looking at the 
Preferences. This is a mistake. Five minutes spent on preferences now will save hours 
of frustration later. Here is exactly what to set. 

Open Preferences: 

• Windows: Edit → Preferences → General  (or Ctrl + K) 
• Mac: Illustrator → Settings → General  (or Cmd + K) 

 

General Preferences 
The first tab is General. Two settings to change here: 
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• Keyboard Increment: This controls how far an object moves when you press an 
arrow key. The default (1pt) is often too small. Set it to 1 mm for print work or 5 
px for screen work. 

• Use Preview Bounds: Turn this ON. It makes the width and height values in the 
Options Bar reflect the visual size of the object including stroke width, rather than 
the mathematical path. Much more intuitive. 

Units Preferences 
Click 'Units' in the left list. Set your units to match your typical work: 

• General: Millimetres (for print work) or Pixels (for screen/web work) 
• Stroke: Points (industry standard for stroke weight) 
• Type: Points (industry standard for type size) 

★★  PRO TIP   
You can change units on the fly for any document without going back to 
Preferences. Right-click on the ruler (the measurement guide along the top or left 
edge of the workspace) and select your preferred unit from the dropdown. This 
changes units for just the current document without affecting your global defaults. 

Performance Preferences 
Click 'Performance' in the left list. Two settings here matter: 

• GPU Performance: Turn this ON if your computer has a dedicated graphics 
card. This enables hardware-accelerated rendering, which makes zooming, 
scrolling, and screen redraw dramatically faster. 

• Animated Zoom: Turn this ON. It makes zooming feel smooth and intuitive 
rather than jumping in steps. 

File Handling Preferences 
Click 'File Handling' in the left list. Important: 

• Number of Recent Files to Display: Increase this to 20 or more. The default 
(10) is too few when you are working on multiple projects. 

• Automatically Save Recovery Data Every: Make sure this is ON and set to 
every 5 minutes. If Illustrator crashes (it is rare in 2026 but still possible), this 
saves you from losing work. 

 

⚠⚠  COMMON MISTAKE — AVOID THIS 
Illustrator does NOT autosave over your original file. The 'Recovery Data' 
preference creates a temporary recovery file in case of a crash. It does NOT replace 
saving your file manually with Ctrl+S / Cmd+S. Develop the habit of saving manually 
every few minutes. Ctrl+S / Cmd+S takes less than a second and has saved my 
work on hundreds of occasions over 25 years. 
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✏✏  TRY IT NOW  —  Configure your preferences now 
11. Open Preferences (Ctrl+K / Cmd+K). 
12. In General: set Keyboard Increment to 1 mm. Turn on 'Use Preview Bounds'. 
13. Click 'Units' in the left sidebar. Set General to Millimetres, Stroke to Points, 

Type to Points. 
14. Click 'Performance'. Turn on GPU Performance (if available) and Animated 

Zoom. 
15. Click 'File Handling'. Set Autosave Recovery to every 5 minutes. Set Recent 

Files to 20. 
16. Click OK to save your preferences. 
17. Your setup is now configured like a professional's. 

 

2.8  Saving Your File — Understanding Illustrator File Formats 
Saving in Illustrator is not as simple as pressing Ctrl+S / Cmd+S, because Illustrator 
gives you several different file format options, each serving a different purpose. 
Understanding this now will prevent a very common and painful beginner mistake. 

The Native Format: .AI 
The .AI (Adobe Illustrator) format is Illustrator’s native file format. Always save your 
working file as .AI. It preserves everything — all your layers, editable text, live effects, 
appearance attributes, and artboards. Think of the .AI file as your master source file. 
You never send this to a printer or client directly; it is your editable original. 

Save as .AI: File → Save (Ctrl+S / Cmd+S) the first time, then just Ctrl+S / Cmd+S from 
then on. 

Exporting for Print: PDF and EPS 
When you need to send artwork to a professional printer, you export as a print-ready 
PDF. This is different from saving as .AI. Use File → Save a Copy → choose Adobe 
PDF. We cover print-ready PDF export in full detail in Chapter 19. 

Exporting for Screen: SVG, PNG, JPG 
For web and digital use, you export rather than save. Use File → Export → Export for 
Screens. This gives you control over resolution, format (SVG, PNG, JPG, WebP), and 
which artboards to export. We cover this in full in Chapter 19. 

 
Format Use For Editable? How to Create It 

.AI Your working master 
file 

Yes — fully 
editable 

File → Save 
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Format Use For Editable? How to Create It 

.PDF Sending to print shops, 
sharing with clients 

Partially (if 
saved with 
layers) 

File → Save a Copy → Adobe 
PDF 

.SVG Web graphics, icons, 
logos for web use 

Yes (code-
based vector) 

File → Export → Export As → 
SVG 

.PNG Screen graphics with 
transparent 
backgrounds 

No — flattened 
raster 

File → Export → Export for 
Screens 

.JPG Photos and complex 
images for web (no 
transparency) 

No — flattened 
raster 

File → Export → Export for 
Screens 

.EPS Legacy print 
workflows, older 
printers 

Partially File → Save a Copy → EPS 

 

★★  PRO TIP   
Always maintain a two-file system for every project: the .AI master file (your 
editable source) and an exported file for delivery (PDF for print, PNG/SVG for 
screen). Name them consistently: logo_brand_v1.ai (working file) and 
logo_brand_PRINT.pdf (delivery file). Never send clients your .AI file unless they 
specifically ask for it and have Illustrator themselves. 

 

2.9  Navigating Your Document — Zooming and Panning 
Before you start designing, you need to know how to move around your document 
efficiently. Navigating Illustrator smoothly is a skill in itself, and it makes a bigger 
difference to your speed than most beginners expect. 

Zooming In and Out 
There are four ways to zoom, and you will end up using all of them depending on the 
situation: 

• Keyboard (fastest): Ctrl+= (Cmd+=) to zoom in, Ctrl+– (Cmd+–) to zoom out. 
Ctrl+0 (Cmd+0) fits the artboard to your screen. Ctrl+1 (Cmd+1) shows 100% 
actual size. 

• Mouse scroll wheel: Hold Ctrl/Cmd while scrolling up to zoom in, scrolling down 
to zoom out. This is the method I use most often. 

• Zoom tool (Z): Click to zoom in, Alt+Click (Option+Click on Mac) to zoom out. 
Drag a rectangle to zoom into a specific area. 

• Navigator panel: Window → Navigator. Shows a thumbnail of your whole 
document; drag the red box to move your view. 


